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Revision History

DATE VERSION DESCRIPTION

April 12, 2018 1.0 Initial version.

April 13,2018 1.2 Additional edits.
Introduction

This document guides you through the process of downloading a standalone vRealize Automation
blueprint from the vRealize Automation appliance and then importing, configuring, and using that
blueprint in vRealize Automation 7.4.

The supplied blueprint, and its associated software components, are provided in a downloadable .zip
file. The blueprint is usable in a vRealize Automation 7.2 and greater installation, although the
download is only available from the vRealize Automation 7.4 appliance.

Note: Unless otherwise indicated, all cited documentation topics are found in the vRealize Automation
version-specific product documentation at https://docs.vmware.com/en/vRealize-
Automation/index.html.
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https://docs.vmware.com/en/vRealize-Automation/index.html
https://docs.vmware.com/en/vRealize-Automation/index.html

1 - Infrastructure Configuration
a. You must configure your vRealize Automation environment to use network profiles to control
static IP ranges for your deployments.

b. Configure an external network profile using the supplied IPAM endpoint within vRealize
Automation is required. For information about how to create and configure network profiles,
see the Creating a Network Profile documentation topic.

Verify that the following values are populated for your network profile:

a. Primary DNS

b. Secondary DNS (can be same as a.)
c. DNS suffix

vmware vRealize® Automation Welcome, fritz. | Preferences | Help | Logout

Administration Containers

Inbox

Edit Network Profile - External

Create a network profile to manage one or more named ranges of static IPv4 network addresses.

Home  Cafalog  fems  Requests Design

< Infrastructure

Key Pairs General | DNS | NetworkRanges [P Addresses
dp New # Edit | X Delete |4k Import from CSV

Reservations Name Description Start IP ~ End IP
DZ WDC Range Small Subset of WDC network 101451546 1014515417

Reservation Policies

Network Profiles

Placement Policy Details for Selected Range ¥
-~
Name: DZ WDC Range Allocated: 0
Description:  Small Subset of WDC network Unallocated: 12
RI=T 31 10.145.154 6f Destroyed: 0 1 2
End IP: [[REENEEN] Expired: 0
Total IP: 12
wl v
< >
oK Apply Cancel

i. Host names must be assigned in the DNS controller database for each of the
reserved static IP addresses that you use in the above network profiles.

ii. Reverse lookup, for each static IP used in the above network profile, must also be
preconfigured.

iii. DNS lookup (running nslookup <IP Address>), for each static-IP used in the
network profile, must also be resolvable by your vRealize Automation
environment and by each deployed machine.

b. Deploy the VM templates to be used for cloning in the vRealize Automation with
infrastructure blueprint to target your vCenter.
c. VRealize Automation virtual appliance:
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https://docs.vmware.com/en/vRealize-Automation/7.4/com.vmware.vra.prepare.use.doc/GUID-B6E703B8-6F46-4BE0-998D-9B6B7E402129.html

vi.
Vii.

Deploy your vRealize Automation 7.4 Virtual Appliance OVF with your required
password, and SSH session-enabled settings into your vCenter. These values are
not updated by the blueprint.

Once the OVF is deployed, power on the machine. Allow the machine 15 minutes
to power on.

Connect to the machine console by using an SSH session and log in as root. Run
the following command to remove the wget utility, if it is installed:

rm $(which wget)

Open the Install the Guest Agent on a Linux Reference Machine documentation
topic and install the guest agent and software bootstrap agent. When finished,
you can shut down the VM OS by using the following shell command:

shutdown -h now. Do not use the power off option

Edit the VM settings for your Virtual Appliance. Under vApp options >
Application, set the following values:

1. Enable SSH service in the appliance: check according to preference.

2. Hostname must be set to localhost.

3. Initial root password: Set this to your preferred password.

4. Leave all other vApp properties, including networking properties, blank.
The virtual appliance can be converted to a template for cloning.
The vRealize Automation template in the blueprint does not use or need a
customization spec. Do not provide a customization spec.

d. laaS Windows VM:

vmware

Verify that all IaaS prerequisites are met for your Windows template, as outlined in
the laaS Windows Servers documentation topic.

If you plan to provision an laaS VM as a standalone computer (not part of a
domain), verify that the local Administrator user has Log on as Service rights in
Local Security Policies = Local Policies = User Rights Assignment. However, if
you plan to provision an laaS VM as a computer in a domain, verify that the domain
user account for running laasS services has the above assigned rights.

VMware Tools must be installed on your laaS Windows machine. See KB 2004754
for instructions on how to install VMware Tools on a Windows machine.

When installing Microsoft SQL Server on your laaS machine, configure a SQL
authentication user (sa), and a password for that user. SQL authentication is an
laas install requirement. If you plan to provision an laaS VM as a computer in a
domain, use a domain user account for accessing vRA SQL Database. Join the laaS
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https://docs.vmware.com/en/vRealize-Automation/7.4/com.vmware.vra.prepare.use.doc/GUID-530ABF4D-E0EA-4266-BEB2-C507CCCDAA9D.html
https://docs.vmware.com/en/vRealize-Automation/7.4/com.vmware.vra.install.upgrade.doc/GUID-47F45416-D297-4C38-A1C0-06E6DFC1EBB5.html
https://kb.vmware.com/kb/2004754

VM to a target domain, add new domain account in Security =» Logins and assign
that user public and sysadmin SQL server roles, then disjoin from that domain.

v. Install the http://support.microsoft.com/kb/816042 KB on your Windows
template. Also install recommended Microsoft security patches.

vi. Verify that there are no virus scanner or protection programs running on the laaS
machine. These programs can interfere with the vRealize Automation installation.

vii. Follow the instructions on the https://<vRA server FQDN>/software/index.htm|

page for downloading and running the following PowerShell script on your laaS
template VM:

prepare vra template windows
Example instructions are provided below.

Windows Software Installers
You can download a zip file to help install the supported Java Runtime Environment, the guest agent, and the software bootstrap agent on your machine.

+ prepare_vra_template_windows zip (RIGHT CLICK and choose SAVE TARGET AS)
Extract the contents of the zip file and after going to the directory where the files were extracted, prepare_vra_template ps1 can be executed as
s PowerShell -NoProfile -ExecutionPolicy Bypass -Command \prepare_vra_template_ps1
OR

« \prepare_vra_template bat

You can manually prepare your Windows reference machine by installing the supported Java Runtime Environment in C-loptwmware-jre, and installing the guest agent and th
Software bootstrap agent

» jre-1.8.0_151-winG4 zip

* vmware-vra-software-agent-bootstrap-windows_7.4.0.0.zip

viii. Create or update a vCenter Customization Specification in Customization
Specification Manager. Use this spec for customizing the Windows (laaS) VM. This
spec is used in the blueprint to set VM parameters such as administrator password,
Windows license, and domain membership. Values other than the hostname are
not updated by the blueprint.

1. Your Windows VM must join a workgroup or a domain.
2. You must set an Administrator password and cannot leave it blank.
This value will be used in the deployment blueprint, and does not get
set later.
3. You must select the UTC option. Only UTC is currently supported.
e. If you are using linked cloning with snapshots, shut down your VMs and take snapshots.
f. If you are not using linked cloning, shut down your VMs and convert them to templates for
cloning.
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http://support.microsoft.com/kb/816042

2 - [aaS Manager Service Configuration
If you expect to use vRealize Orchestrator extensibility workflows (such as the MachineProvisoned
workflow used in this content package) to run longer than the default setting of 30 minutes to
avoid timing out, update the following setting:
Infrastructure = Administration = Global Settings =» Group: Extensibility =» Extensibility
lifecycle message timeout:

Group: Extensibility

Set to True will disable extensibility service. (Default it is set to

False) False

General Disable extensibility

The maximum amount of time the master workflow gets blocked

on each state waiting for extensibility events. 01:00:00

General Extensibility lifecycle message timeout
Note: If you update the timeout setting, you must restart the laaS Manager Service.

3 - Import Blueprint & Software Component Contents

Use VMware CloudClient 4.x to import the vRAIaaSAppForvSphere.zip file that you downloaded
from the vRealize appliance into your vRealize Automation tenant. The zip file contains the out-of-the-
box vRealize Automation blueprint and several software components that are used in the blueprint.

The blueprint name is vRealize Automation with Infrastructure. The blueprint ID is
vRealizeAutomationwithinfrastructure.

You can download CloudClient at https://code.vmware.com/tool/cloudclient. When you download
CloudClient, also download the CloudClient documentation.

See the CloudClient documentation for information about using the vra content import
command to validate and then import the blueprint and software component contents into your
environment.

Examples
Examples of these operations are shown below:

Example 1:

cloudclient>vra content import --path "<folder>\vRAlaaSAppForvSphere.zip" --dry-run NO --
resolution OVERWRITE --verbose

R +
| Notification|
Hommmmmmmmeee +

* Performing import precheck for [<folder>\vRAlaaSAppForvSphere.zip]. Note this operation does
not import any content.
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https://code.vmware.com/tool/cloudclient

[{
"contentld" : "Software.ReleaseVMwareCommonFunctionsshell",
"contentName" : "Release-VMware-Common-Functions-shell",
"contentTypeld" : "software-component”,
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],
"operationErrors" : [ ]

A
"contentld" : "Software.StandaloneVMwareCommon",
"contentName" : "Standalone-VMware-Common",
"contentTypeld" : "software-component”,
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],
"operationErrors" : []

b A
"contentld" : "Software.StandaloneVMwarevRACommon_Functions",
"contentName" : "Standalone-VMware-vRA-Common_Functions",
"contentTypeld" : "software-component”,
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],
"operationErrors" : [ ]

b A

"contentld" : "Software.StandalonevRAServer72andHigher",
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"contentName" : "Standalone-vRA-Server-7.2 and Higher",
"contentTypeld" : "software-component”,
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],
"operationErrors" : [ ]

b
"contentld" : "Software.StandaloneVMwarevRAConfiglaaS72andHigher",
"contentName" : "Standalone-VMware-vRA-ConfiglaaS-7.2 and Higher",
"contentTypeld" : "software-component”,
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],
"operationErrors" : [ ]

LA
"contentld" : "Software.WindowsRebootcomputer",
"contentName" : "Windows - Reboot Computer"”,
"contentTypeld" : "software-component”,
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],
"operationErrors" : [ ]

b
"contentld" : "Software.StandaloneVMwarelaaSServer72andHigher",
"contentName" : "Standalone-VMware-laaS-Server-7.2 and Higher",
"contentTypeld" : "software-component”,
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],

"operationErrors" : [ ]
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b

"contentld" : "Software.StandaloneVM_Hostname_Domain_Resolution_Windows",
"contentName" : "Standalone-VMware-Hostname-Domain-Resolution-Windows",
"contentTypeld" : "software-component”,
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],
"operationErrors" : [ ]

b
"contentld" : "Software.StandaloneVMwareSLESUpdate72andHigher",
"contentName" : "Standalone-VMware-SLES-Update-7.2 and Higher",
"contentTypeld" : "software-component”,
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],
"operationErrors" : [ ]

b
"contentld" : "vRealizeAutomationwithInfrastructure",
"contentName" : "vRealize Automation with Infrastructure",
"contentTypeld" : "composite-blueprint",
"operationStatus" : "WARNING",
"messages" : [ "Found matching content, import will overwrite this content." ],
"operationErrors" : [ ]

1]

+ +

| Import Precheck Result|

+ +

WARNING: Import precheck finished with warnings.
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* 10 content(s) were validated with warnings.
* Nothing was imported.

* You may choose to run with '--precheck WARN' to proceed with import even when there is
warning.

The above message confirms that the blueprint and its related software components were validated
with warnings for import into a target vRealize Automation tenant. If this is the first time that you are
importing the software components, you will likely not see any warnings.

Example 2

cloudclient>vra content import --path "<folder>\vRAlaaSAppForvSphere.zip" --dry-run NO --
resolution OVERWRITE --precheck WARN

R +
| Notification |
o +

* Performing import precheck for [<folder>\vRAlaaSAppForvSphere.zip]. Note this operation does
not import any content.

4 4
T

| Import Precheck Result|

+ +

WARNING : Import precheck finished with warnings.
* 10 content(s) were validated with warnings.
* Nothing was imported.

* Run with '--verbose' option to see details.

R +
| Notification|
RS +

* Importing [<folder>\vRAlaaSAppForvSphere.zip]. Note this operation will import the given
content unless it encounters failures.
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WARNING : Import finished with warnings.
* 10 content(s) were imported successfully.

The above message confirms that the vRealize Automation blueprint and its related software
components were successfully imported into the target vRealize Automation tenant.

4 - vRealize Orchestrator Configuration
a. One-time setup of the Event Broker extensibility package for vRealize Orchestrator:

i. Import the supplied com.vmware.ctoa.ebs.extensibility.package file as described
in the Import a Package topic in the vRealize Orchestrator documentation.

ii. Configure vRealize Automation host settings for vRealize Orchestrator plug-ins as
described in the Add a vRealize Automation Host topic in the vRealize Orchestrator
documentation.

iii. Configure the vRealize Automation laa$S host as described in the Add an laaS Host
topic in the vRealize Orchestrator documentation.

Sample configurations for vRealize Automation and the laa$S plug-ins are shown
below:
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https://docs.vmware.com/en/vRealize-Orchestrator/7.4/com.vmware.vrealize.orchestrator-using-client.doc/GUIDD3CC26B9-10A9-4C2E-BD9D-799B07EF2D76.html
https://docs.vmware.com/en/vRealize-Orchestrator/7.3/com.vmware.vrealize.orchestrator-use-plugins.doc/GUID-C48AE613-2DD0-4B80-91A3-6A4BD63B4B2E.html
https://docs.vmware.com/en/vRealize-Orchestrator/7.3/com.vmware.vrealize.orchestrator-use-plugins.doc/GUID-92C02A27-B602-48F7-9CFB-40D00F77A35A.html

vmware

() VMware vRealize Orchestrator - administrator @ cava-pn-210-010.eng.vmware.com - [Server] —

vmware vRealize” Orchestrator

& 2 s 0E]

» [=] sump
» EX PowerShel
» b 2map
> Team Foundation Server (Code Stream)
> vRealize Automation 7 (Code Stream)
v @ vRealize Automation Infrastructure
» ¥ cava-p-12-102.eng.vmware.com [https:/cava-p-12-102.eng.vmware. com/]
> B8 AP
» & soap
v @ vRealize Automation
» @ cava-pn-210-010.eng.vmware.com QE [https://cava-pn-210-010.eng.vmware.ct
010.eng.
» @ Default [https:/icava-pn-210-010.eng.vmware.com] [vsphere.local]
» = vRO Configuration
» S nsx
» [l Dynamic Types
» B 53H
> “% Azure
» [¥] Active Directory
» ¥ vRO Multi-Node
» Jenking (Code Stream)
> G vSphere vCenter Plug-in
» @A HTTP-REST
» EH saL Pug-in
> vRealize Automation § (Code Stream)

| Tools v| Help v| earch for

% 0O 7 VCACHost - Default [https://cava-pn-210-010.eng.vmware.com] [qe]

J General | Custom properies

Lastupdated - 12 seconds ago.

E Tags

Global tags

Usertags

pageSize 100
tenant qe
operationTimeout G0
sessionMode PerUser Session

name Default

id cb2d0d7 d-5b38-44de-8404-600a23cb4csh
displayMame Default [hitps:/icava-pn-210-010.eng.vmware.com] [qe]
username cafe-z5QEFalBjA@vsphere.local

url https:ficava-pn-210-010.eng.vmware.com

connectionTimeout 30

iv. Run the Setup EBS Extensibility workflow located in the EBS Extensibility —

Configuration folder.

Select the vRAHost instance that corresponds to the target tenant, as in the

following example:
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() Start Workflow : Setup EBS Extensibility X

1 EBS Extensibility

Action

1b Property configuration ["'Stﬂ“ T]

# vRAHost

("4 Default [ttpsffcava-pn-210-010 eng.vmware.com] [vsphere local] )

Cancel Back Next Submit

Select All for machine properties.

() Start Workflow : Setup EBS Extensibility X

1 EBS Extensibility
L4 1a Installation

1b Property configuration Al

Include machine properties

Mone
Custom

Cancel Back Next Submit
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- Click Submit and then monitor the vRO log in the vRO development client to check for
messages confirming your EBS extensibility setup.

[2018-01-16 16:56:00.171] [I] Creating workflow subscription...

[2018-01-16 16:56:00.738] [I] Workflow subscription EBS Extensibility - Provision created.
[2018-01-16 16:56:00.993] [I] Creating workflow subscription...

[2018-01-16 16:56:01.334] [I] Workflow subscription EBS Extensibility - Lifecycle created.
[2018-01-16 16:56:01.446] [I] EBS Property group with ID 'EBSExtensibility’ will be created
[2018-01-16 16:56:01.830] [I]

[2018-01-16 16:56:01.872] [I] The following property can be used if the property group
'EBS Extensibility' is assigned to the blueprint:
EBS.BuildingMachine
EBS.MachineProvisioned
EBS.UnprovisionMachine

EBS.DisposingPre

EBS.DisposingPost

EBS.MachineCloned

EBS.InitialPowerOn

EBS.On

EBS.Off

EBS.Reboot

EBS.Requested

EBS.Expired

b. Configure the connection to a vCenter server as described in the documented in the Configure the
Connection to a vCenter Server Instance topic in vRealize Orchestrator documentation.

c. Import the supplied com.vmware.cse.vrarelease.package file as described in the Import a Package
topic in vRealize Orchestrator documentation.

d. Update the vRealize Orchestrator configuration element (vCACCava =» Server) settings to match
the host names in the target vRealize Automation environment as described in the Configuration
Elements topic in vRealize Orchestrator documentation.

Select Design from the vRealize Orchestrator client drop-down menu.
i. Select the Configurations view.
ii. Expand the vCAC Cava = Server element, click Edit and configure the following properties:

a. Specify the FQDN for the following elements in the Attributes tab.
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An example of these configuration attributes is shown below:

vcacHostname - FQDN of your vRealize Automation server
iaasHostname - 1aa$S of your vRealize Manager Service server

General | Aftributes | Events  Permissions

Server

R+ X 3 [0 W

Name Type ion

veacHostname Sirin cava-pn-210-010.eng.vmware.com FQDN of vRA Vi tload balancer for emvironment

iaasHostname string 12-102. enavmware com EQDlidenerTTanzger Senvice Nostioad balancer

vraFin siring 0000000 OCCCNO0CI0CIC OO0 Not used

iaasFi string 3RO OO0 K KR IO 0L KK K KR IO IO XA XK | Notused

sehusar siring roat Mot used

sshpwil SecureSting I | Notused

| cancel [ Revert | | Sawe [ Save and close
iii. Click Save and Close to save your configuration settings.

e. (OPTIONAL if using custom e-mail notifications) Change vRealize Orchestrator
configuration element (vCACCava =» Notifications) settings to specify settings such as
company SMTP server, user name, and password. You can also specify the fromAddress and
fromName values to display the sender e-mail address and sender name in messages.
An example is shown below:

.} VMware vRealize Orchestrator - administrator @ cava-pn-210-010.eng.vmware.com - [Server] — O e

General | Aftributes | Events Permissions

Notifications

e X 3 W

Name Type Value Description

fromAddress string vra notifications@vsphere.local mail fram address, which appears in mail client
toAddress string |send mail to this addresses

fromMName string vRA Content Deployment Motifications mail from name, which appears in mail client
smitpHost string smip.company.com SMTP Server IP/FQDM used to send mails
smitpPort number 250 SMTP Port used to send mails

username string email authentification username, if needed
password SecureString email authentification password. if needed
useSsl boolean () Yes (® No Use §35! connection far SMTP?

usestarTls hoalean () Yes (® No StartTLS for SMTP?

l Cancel J l Revert J l Save J l Save and close J
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5 - vRealize Automation Tenant Configuration

a. Runinventory data collection on the compute resource corresponding to your vCenter to
collect the template and VM changes that you have made.

b. Create a VRO endpoint as described in the Create a vRealize Orchestrator Endpoint topic in
vRealize Automation documentation.

c. Configure the vRO endpoint to enable Event Broker subscriptions-based extensibility as
described in the Configure the Embedded vRealize Orchestrator Server topic in vRealize
Automation documentation.

d. Create areservation as described in the Create a Reservation topic in vRealize Automation
documentation, being sure to use a resource pool and assign the network profile that you
created in section 1 (Infrastructure Configuration).

An example reservation is shown below:

Edit Reservation - vSphere (vCenter)
Change settings in a listed reservation.

General Resources MNetwork = Properties ~ Alerts

Machine quota: 2002 1©
*Memory (GB): Physical Total Reserved Total Allocated This Reservation
1024 1000 ] 1000
Storage (GB): Storage Path Physical  Free Total Reserved ;g'seﬁfgwa"m m}i;‘;ﬁewat"’” prioity  Disapied
# W] @ veac-perfiab 5999 2107 1200 1200 0 1 No
veac-scale.. 3000 862 0
veac-scale.. 3000 629 0
vcac-scale... 3000 615 0
l datastoret (10) 272 10 0
[] ﬁ datastoret (11) 272 220 0
] ﬁ datastoret (12) 272 208 0
] ﬁ datastore1 (13) 272 85 0
Resource pool: | Deployments v

(OPTIONAL If using custom e-mail notifications). Click Administration=» Events =»
Subscriptions and create a non-blocking subscription for the blueprint to the Catalog item
request completed event by using the Get Payload Properties - Blueprint or Catalog requests -
send E-mail notification vRO workflow as a target.

Base your subscription on conditions as shown in the following example.

Use the BlueprintID value for the conditions as shown in the following graphic.
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Edit Workflow Subscription

Event Topic

Conditions

Workflow

Details

Specify whether the workflow should be run for all events or based on conditions.

O Run for all events

@ Run based on conditions

All of the following
User name
Any of the following
Data > Blueprint ID

Data > Blueprint ID

& Add expression
¢ Add expression

v

X
v |Equals

~ |Contains

v Doesnote... v |Nothing

v vRealizeAutomation... v X
~  vRealizeAutomation... v 3
@Oonstant
() Fied

vRealizeAutomationwithinfr:

Use the Get Payload Properties - Blueprint or Catalog requests - send E-mail notification vRO
workflow as a target for the non-blocking subscription as shown in the following graphic.

Edit Workflow Subscription

Event Topic ~ Conditions =~ Workflow

Select a workflow:
4 () Orchestrator
() EBS Extensibility
(. Library
(Jae
(. System
4 | vCAC Cava
4 | Notification

Details

Selected workflow:
Name:

Description:

Input parameters:

Name

payload

[ Get Payload Properties - Blueprint or Catalog requests - send E-mail notification
[ Get VM properties when catalog item succeed NESTED BP
3 send email report
g Send report for provisioned multimachine
(Jvcenter

() vSphere blueprint

Output parameters:

Name

(et Payload Properties - Blueprint or Catalog requests - send E-mail notification

Developed to handle e-mail notification for Cava requests for most of Blueprints -
regular and now nested, the child workflow should be "Get VM properties when
catalog item succeed NESTED BP"

Type

Properties

Displaying 1 -1 of 1

Type

No parameters

Publish the newly created subscription and verify that its status appears as Published by selecting
Administration > Events > Subscriptions as shown in the following example.

For information about Event Broker Subscription publishing, see Working with Provisioning and Life

Cycle Workflow Subscriptions and Scenario: Create a Post-Provisioning Snapshot Workflow
Subscription in vRealize Automation documentation.
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Advanced Search

4k New # Edit @ Unpublish X Delete

Name « Description Event Topic ID Blocking
BusinessGroupEB com.vmware.csp.core No
Business Group Event com.vmware.csp.core No
Cava Get Payload Properties - Blueprint o Developed fo handle e-mail notification for Cava requests for most of Bluep com.vmware.csp.com No

EBS Extensibility - Lifecycle Subscription for EBS Extensibilty. DO NOT delete or modify. com.vmware. csp.iaas Yes
EBS Extensibility - Provision Subscription for EBS Extensibilty. DO NOT delete or modify. COM.vmware.csp.iaas Yes

Reply

No
No
No
No
No

Timeout (min}

120
120

NOTE: You can customize the content of notification e-mails by changing the Get VM properties part
of deployment and use them for SUCCESS E-mail generations script operator in the Get Payload

Properties - Blueprint or Catalog requests - send E-mail notification vRO workflow.
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s 19



6 - Blueprint Level Configuration Updates

a. InvRealize Automation, open the vRealize Automation blueprint in each VM and select a
Clone or Linked Clone build information action for each VM.
Verify that the correct VM template for each component is selected as a Clone From
source and, in the case of LinkedClone, that its latest snapshot corresponds to a state in
which all the previous prerequisites are configured.
For the laaS Windows machine, add the desired customization spec as shown in the
following example:

laa$s

General Build Infermation Machine Resources Storage = Network  Security  Properties Profiles

Blueprint type: | Server v 0
Action: |Clone v D
“ Provisioning workflow: | CloneWaorkflow v D

*Clone from: |win2012-iaas-domain

Customization spec: |Windows-laaS-Domain

b. Click the Storage tab for each VM and, if present, delete the 1 GB drive that contains the
DELETE THIS label.

c. Customize any necessary reservation policies, machine prefixes, and lease settings.
Modify or verify custom property settings in the overall blueprint as described below.

Open the Custom Properties or Property Groups Ul page

In vRealize Automation, click Design > Blueprints and select the blueprint that you want
to open from the list.

Click the Blueprint Properties icon and then click Properties > Property Groups or Custom

Properties.

Blueprint Properties v
ind User blueprint — General  MSX Sefings  Properties
Design Canvas Blueprint Properties

“sProperty Groups  Custom Properties

NOTE: All custom properties that are not listed below can be left as is.
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Custom Properties for vRA — vSphere Machine:

i. vcac_va_license_key — enter your vRealize Automation developer license key.

ii. Verify that the EBS Extensibility custom property group, which was created
automatically in section 4 (vRealize Orchestrator Configuration) is listed in the
Property Groups list for your open blueprint.

Add Property Groups

[[] Name = Description
[] Container host properties with certificate aut...  Sample property group with custom properties for container host using certificate and private k...
[ Container host properties with user/passwor... ~ Sample property group with custom properties for container host using user and password cre...
i/} EBS Exiensibilty Property group that need to be assigned to use EBS Extensibility
Page |1 of 1 = Displaying 1 - 3 of 3
OK Cancel

iii. EBS.MachineProvisioned — Verify that the Global ID of the Release - Machine
Provisioned activities EBS vRealize Orchestrator workflow is entered. That ID can
be found by selecting the workflow in the Orchestrator client. See the following
image as an example.

Mame Release - Machine Provisioned activities EBS

D b9d8a5ba-72f2-4b0a-a042-528fc2ce31b6

Version

Workflow icon

iv. vcac_va_root_password — The root password for the vRealize Automation virtual
appliance should match the one configured in section 1 (Infrastructure
Configuration) for the corresponding VM template.

Custom Properties laaS — vSphere Machine

i iaas_va_admin_password — Specifies the Windows VM Administrator user
password (for Administrator user if local, for Domain user if laaS VM joins a
domain).

ii. iaas_va_admin_user — Specifies the Windows VM Administrator user — (for
Administrator user if local, for Domain user if laaS VM joins a domain).
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Verify that the custom property group EBS Extensibility, created in section 1
(vRealize Orchestrator Configuration) appears in the Property Groups list.
EBS.MachineProvisioned — Verify that the Global ID of the Release -

MachineProvisioned - Set VM Hostname vRealize Orchestrator workflow is listed.

You can find the global ID value by selecting the workflow in the Orchestrator
client.

Custom properties - Common software component:

ntp_servers — Specifies the NTP server(s) address or hostname for the network
where VMs will be deployed
OPTIONAL. If the laaS VM joins a domain, specify values for the following
properties for Domain user with rights to rename computers on the Domain used
in the Standalone-VMware-laaS-Server-7.2_and_Higher_1 component.

e ad_domain — Specifies the domain name (for example company.com).

e ad_password — Specifies the domain administrator user password.

e ad_username — Specifies the domain administrator user name.

Custom properties - Standalone-vRA-Server-7.2_and_Higher_1 software component

Vi.

Vii.
viii.

vmware

cert_sign — Specifies the SHA2 value for self-signed certificate. Default (sha256)
can be used.

certificate_country_code — Specifies the self-signed certificate country code.
Default (US) can be used.

certificate_organisation_name — Specifies the self-signed certificate organization
name. Default (Organisation) can be used.

certificate_organisation_unit — Specifies the self-signed certificate organization
unit. Default (CMBU) can be used.

days_valid — Specifies the self-signed certificate validity range. Default (1825) can
be used.

horizonpass — Specifies the Administrator user password for the default vRA
tenant (administrator@vsphere.local).

iaas_db_name — Specifies the laaS database name. Default (vra) can be used.
iaas_db_windows_auth — Specifies the flag whether to use Windows
authorization for connection to SQL database. Default (false) can be used if
default user (sa) is used for connection, otherwise need to be changed to true.
iaaspassphrase — Specifies the laaS database encryption passphrase, secured
string value. Non-default value recommended.
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vmware

Xi.

Xii.

xiii.

Xiv.

mssql_user — Specifies the laaS database username used for connection to SQL
database. Default (sa) can be used or, in case when laaS VM joins a Domain and
has a pre-defined domain service account added, a domain user account.
mssql_pass — Specifies the laaS database password for SQL Server authentication
user above. Should match password for default sa user or password for domain
user service account if that is used on the laaS VM template.
vsphere_agent_endpoints — Specifies the Name of vSphere endpoint to configure
for vRealize Automation vSphere proxy agent. The name of the endpoint that gets
created later in the product must match this value. One agent must be installed.
Default value (vCenter) can be used.

vsphere_agent_names — Specifies the name of vRealize Automation vSphere
proxy agent service that gets installed on laaS machine. One agent must be
installed. Default value (vCenter) can be used.

web_site_name — Specifies the name of the default IIS Web site for laaS
components. Default (Default Web Site) can be used.

An example of some of these property values is shown below:

Name -

mssql_pass
mssql_server
mssql_user
ntp_servers
single_iaas_password
single_iaas_user
sleep_max

sso_tenant

timezone
use_existing_database
use_single_iaas_credentials
vecac_build_type
vcac_va_hostname
veac_va_ip
vcac_va_license key
vra_agent_hostnames
vra_agent_passwords
vra_agent_usernames
vra_common_functions_file_
vra_dem_hostnames
vra_dem_passwords

vra_dem_usernames

wra |h foadn

Description

Local or domain SQL Server ...

Local or domain SQL Server

NTP servers for Time setting

Pwd for Local or Domain user...

Local or Domain user for run...

Time Zone for vRA and 1aas ...

Either ob or sb, if this propert...

The vRA VA FQDN
The vRA VA IP

vRA appliance license key

Path to script file with functio

Type
Secure String
String
String
String
String
String
String
string
string
String
String
String
String
String
String
string
Secure String
String
String
String
Secure String

String

Strinn
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Binding

No
Yes
No
Yes
Yes
Yes
MNo
No
Yes
No
No
Yes
Yes
Yes
Yes
Yes
Mo
No
Yes
Yes
MNo
No

Voo

Value

s

_resource~Standalone-VM_Hostname_Domain_Resolution_Wi
sa

Common-ntp_servers
Common-~iaas_va_admin_password
Common-~iaas_va_admin_user

1200

vsphere.local

Common-~timezone

false

true

Common-~build_type
_resource~Common~vcac_va_hostname
Common-~vcac_va_ip
vRA~vcac_va_license key

_resource~Standalone-VM_Hostname_Domain_Resolution_Wi..

_resource~VMware-vRA-Common_Functions_1~vra_common_f

_resource~Standalone-VM_Hostname_Domain_Resolution_Wi..

racAlrta-Camman-~urar ua hnetnama
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After making changes to custom properties and property groups settings, click OK.
Click Save to save blueprint changes and click Finish to exit out of the saved blueprint.
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7 - Catalog Management
a. Publish the blueprint that you just updated and saved in section 6 (Blueprint Level Configuration
Updates) by selecting the blueprint from the Blueprints view and clicking Publish.

For information about publishing, see Publishing a Blueprint in vRealize Automation documentation.

Inbox Design Administration (!

Blueprints
Create and manage b ..ep:-.:-.ls\gih a bluepri
the catalog.
o New | # Edit [3Copy () Publish
Name Description

The blueprint is published to the vRealize Automation services catalog.

b. Configure the published blueprint catalog item with the appropriate entitlements as described in
Creating Entitlements and Configure a Catalog Item topics in vRealize Automation documentation.
An example of catalog item configuration is shown below:

Configure Catalog ltem

General Entitlements

Source: Blueprint Service

Resource type: Deployment

Description: s ~
E used v
lcon: Browse._ ..
Recommended size: 100 x 100 pixels

Preview Listview Catalog view Detail view
Status: |Active v
Quota: -
Service: | Standalone vRA Service v

New and noteworthy

For more information about the catalog and managing catalog items, services, and entitlements, see
the Managing the Service Catalog topic in vRealize Automation documentation.
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8 - Blueprint Provisioning and Deployment
Request provisioning of the published blueprint and verify its progress.

a. In vRealize Automation, click Catalog.

b. Locate the published blueprint, click Request and respond to prompts.

An example of a successful vRealize Automation blueprint provisioning request is shown below:

Deployment: vRealize Automation with Infrastructure

Execution information for | vRealize Automation with Infrastructure Upd +

Name

) VRA

| 12aS

| 12aS[0]
VRA[O]

Common-Fu...

VMware-vRA
Common[0]

Standalone-

Standalone-...
Standalone-...
Windows_-_...

Standalone-...

Status

® Successful
@ Successful
@ Successful
@ Successful
@ Successful
@ Successful
@ Successful
@ Successful
@ Successful
@ Successful
@ Successful

@ Successful

Details

Request succeeded. Created oem-iaas-54.

Request succeeded. Created oem-vra-562.

| Waiting for -

vRA

laas

laas

VRA[O]. laaS

laaS. Common-Functions[0]

VRA[0], laaS, Common-Functions[0], laas
|aas, laas[o]

laa3, Common[0], Commoen-Functions[0]
Standalone-VM_Hostname_Domain_Res.
Standalone-VMware-laaS-Server-7.2_an. ..
Standalone-\VM_Hosiname_Domain_Res.

Standalone-VV_Hostname_Domain_Res.

Component ID
VRA

l1aas

l1aas

VRA
Commen-Functi...
VMware-vRA-C
Common
Standalone-VM
Standalone-VM...
Standalone-VM...
Windows_-_Reb...

Component Type
vSphere (vCent
vSphere (vCent
vSphere (vCent
vSphere (vCent
Release-VMwar.
Standalone-VM
Standalone-VM
Standalone-VM
Standalone-VM....
Standalone-VM...
Windows - Rebo...

Standalone-WM....

Standalone-WM. ..

Standalone-vRA. ..
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c. If the request fails or is only partially successful, examine the failed tasks by clicking the circled
button with the ellipses. Make any necessary adjustments or configuration changes in the blueprint,
based on the exceptions, then request priovisioning again.

Deployment: vRealize Automation with Infrastructure

Execution information for | vRealize Automation with Infrastructure Upd +

Name Status Details Waiting for Component ID

2) VRA @ Successful VRA

_) 1aas @& Successiul VRA l1aas

=) VRA[O] & Successful Request succeeded. Created oem-vra-635. laas vRA

- 1aas[o] @ Successful Request succeeded. Created oem-iaas-36. laas laas
Common-... @ Successful VRA[O], laasS Common-Fun..
ViMware-v @ Successful Common-Fun VMware-vRA-
Standalon... & Successful laas, laas[0] Standalone-V..
Common[0] @ Successful [-) wRA[0], Com... Common
Standalon... @ Successful Common[0], .. Standalone-V..
Slandal One or more of the spawned tasks failed. See task log for more details Common[0], | Standalone-V
Standalon... A\ Aborted Marking as ABORTED. A preceding component request has Failed or parent request Windows_-_R...  Siandalone-V..
Standalon... A\ Aborted Marking as ABORTED. A preceding component request has Failed or parent request Common([0], v... Standalone-v...
Windows_... A\ Aborted Marking as ABORTED. A preceding component request has Failed or parent request laaS, 1aaS[0], ... Windows_-_R...

usel /

vmware

VMware, Inc. 3401 Hillview Avenue Palo Alto CA 94304 USA Tel 877-486-9273 Fax 650-427-5001 www.vmware.com

Copyright © 2015-2018 VMware, Inc. All rights reserved. This product is protected by U.S. and international copyright and intellectual property laws. VMware products are covered by one or more patents listed at
http://mww.vmware.com/go/patents. VMware is a registered trademark or trademark of VMware, Inc. in the United States and/or other jurisdictions. All other marks and names mentioned herein may be trademarks of their respective
combnanies.



9 - Troubleshooting
Support for TLS 1.2 protocol

Steps to enable TLS 1.2 protocol support if that secured communications protocol is enforced on the
VRA appliance — without it vRealize Automation agents might fail to establish communication with the
appliance.

See the Transport Layer Security Protocol topic in Microsoft documentation.

For TLS 1.2 to be enabled and negotiated on servers that run Windows Server 2008 R2, you must
create the DisabledByDefault entry in the appropriate subkey (client or server) and set it to 0. The
entry is in the registry and is set to 1 by default.

Applicable versions: As designated in the Applies To list that is at the beginning of this topic excluding
those versions prior to Windows Server 2008 R2 and Windows 7.

Registry path: HKLM SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols
To disable the TLS 1.2 protocol, create an Enabled entry in the appropriate subkey. This entry does not
exist in the registry by default. After you have created the entry, change the DWORD value to 0. To

enable the protocol, change the DWORD value to 1.

TLS 1.2 subkey table

Subkey Description Default
Client Controls the use of TLS 1.2 on the client. Enabled
Server Controls the use of TLS 1.2 on the server. Enabled
DisabledByDefault Flag to disable TLS 1.2 by default. Enabled
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Performance Issues
A. Deployments might start to fail with an error such as that shown below.

<machine_name>: InstallSoftwareWorkflow SendWorkitem Exception: Machine
<machine_name>: InstallSoftwareWorkflow. Install software work item timeout.

You can display errors by clicking Infrastructure =» Monitoring =»Log.

e If you see these issues after a few days of successful provisioning, check the memory
usage on your vRealize Orchestrator appliance by running: cat /proc/meminfo from
its console.

e If you see that you are running low on MemFree (if setting is less than 2GB), increase
the virtual appliance memory to 30 GB and then restart the virtual appliance.

RS


https://msdn.microsoft.com/en-us/library/windows/desktop/aa380516(v=vs.85).aspx

e If you have an HA system, apply the same amount of memory to all secondary VAs
and restart them all at the same time.

B. If you see the same install software error as above without ever having a successful deployment, it
is likely that either the guest or software agent are misconfigured and need to be reinstalled. You can

reinstall as described in the Install the Guest Agent on a Windows Reference Machine topic in vRealize
Automation documentation and in section 1 (Infrastructure Configuration).

C. After cloning your vRealize Automation virtual appliance to a template, the clone fails with an error
stating that the initial OVF root password needs to be set.

If you see the described error, set the OVF root password again on the cloned template by
converting your template back to a VM and then editing the VM settings in vCenter. Click
vApp Options=>Initial root password, reenter your password, and save your settings. You can
then convert your VM to a template and retry your clone request.

D. If your deployed Windows machine is not getting the correct static IP, ensure that a vCenter
customization specification is being used in the blueprint for the laaS component.

E. If none of your machines are getting a static IP assigned from vRealize Automation:

e Verify that you properly configured your network profile in your reservation. See Edit
a Reservation to Assign a Network Profile.

e Verify that the reservation specified in your machine components is configured to use
the correct reservation policy. See Choosing a Reservation Scenario and Reservation
Policies.
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